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Overview

This subsection discusses the following topics:
• How to locate the latest version of the NS-Link device driver and related 

installation documentation.
• Information about NS-Link, such as:

- Installation quick reference for experienced users.
- NS-Link hardware, software, and device connectivity requirements.
- IP or MAC addressing issues.
- Overview of port sharing.

How to Use this Document

You can use the interactive Table of Contents to locate the information you need. 
Red, underscored items are links to URLs. Blue, underscored items are links 
within this document or to another document on the media. 
Note: If you copy this document from the ftp/web or CD and do not use the 

procedure discussed on the CD, you will get an error message when selecting 
hyperlinks outside of this document.

Locating Hardware Installation Documentation

Use the hardware installation documentation to install the hardware before 
installing NS-Link. The hardware installation documentation is available on the 
Comtrol CD ships with your product or you can download the current version from 
the ftp site using the following links.
• DeviceMaster RTS Hardware Installation and Configuration or

ftp://ftp.comtrol.com/Dev_Mstr/RTS/HW_Doc/RTS-Install.pdf .
• RocketPort Serial Hub ia Hardware Installation document or

ftp://ftp.comtrol.com/RPSH_ia/HW_Doc/2000169.pdf).
• RocketPort Serial Hub Si 2-Port Hardware Installation document or

ftp://ftp.comtrol.com/RPSH_Si/HW_Doc/2_Port/2000153A.pdf.

Locating NS-Link Software and Installation Documentation

You can download the latest NS-Link device driver updates at no charge from the 
Comtrol web site at: http://support.comtrol.com/download.asp. Always check the 
web or ftp sites to make sure that you have the current driver and documentation. 
The software files that you download from the web site are self-extracting zipped 
files that you must extract before installing.
The Comtrol CD that ships with your product can streamline the installation of 
your product. When loaded on a system running a Microsoft operating system, the 
CD opens a menu system (unless the autorun feature is disabled). 
Note: If the autorun feature has been disabled, open the Readme.pdf file at the root 

of CD to start the menu system.

ftp://ftp.comtrol.com/Dev_Mstr/RTS/HW_Doc/RTS-Install.pdf
ftp://ftp.comtrol.com/RPSH_ia/HW_Doc/2000169.pdf
ftp://ftp.comtrol.com/RPSH_Si/HW_Doc/2_Port/2000153A.pdf
http://support.comtrol.com/download.asp


Overview 6 

NS-Link Overview

NS-Link Overview

The following subsections discuss NS-Link features and topics that you may want 
to review before installation.

NS-Link Installation 
- Quick Reference

If you are familiar with installing Comtrol software, you can use the following 
procedure as a quick reference:
1. Install the hardware.
2. Run the self-extracting NS-Link file.
3. If necessary, remove the existing NS-Link device driver.
4. Install NS-Link and the configure the port characteristics in NS-Link setup.
5. Shut down and restart the system.
6. If necessary, program the IP address into the device.
7. Connect your serial devices.

NS-Link 
Requirements

This subsection discusses installing and configuring the NS-Link driver for the 
following hardware platforms:
• DeviceMaster™ RTS

Note: Install the NS-Link driver if you want to use the ports as native COM 
ports. You can also configure the ports as sockets after the NS-Link 
installation. 

If you want to configure the port for socket mode or serial tunneling, you 
do not need to install NS-Link. See the DeviceMaster RTS Installation 
and Configuration Guide for socket configuration information.

• RocketPort® Serial Hub ia or RocketPort Serial Hub Si
The NS-Link driver requires at least one host system running one of the following 
operating systems:

• Microsoft® Windows® NT 4.0, RAS or RRAS is required to support Remote 
Access Service and Microsoft supports up to 256 RAS ports.

• Windows Terminal Server and Citrix® MetaFrame®

Connectivity 
Requirements

An Ethernet connection, either to an Ethernet hub or to a network interface card 
(NIC) in the host system. See the hardware installation documentation (Page 5) 
for information regarding hardware installation.

Product Type Connected to Ethernet 
Cable Connector 

DeviceMaster RTS 1 Ethernet hub or NIC Standard 10/100 ETHERNET

DeviceMaster RTS 1 
Embedded Ethernet hub or NIC Standard RJ45 port

DeviceMaster RTS 4/8/
16 with external power 
supply

NIC Standard DOWN

Ethernet hub Standard UP

DeviceMaster 16/32RM 
with internal power 
supply

Ethernet hub or NIC Standard 10/100 NETWORK
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IP or MAC Addressing Issues

IP or MAC 
Addressing Issues

This is an overview of IP and MAC addressing issues that may affect how you 
configure the Comtrol device with a brief discussion of advantages of either 
method.
The IP addressing scheme has the following advantages:
• Uses an industry standard protocol.
• Allows you to configure systems to use ports on the Comtrol device that are 

outside of the host system’s Ethernet segment. 
Note: This IP address must be a unique reserved IP address, do not use an 

address from a dynamic address pool. If necessary, see the system 
administrator for an IP address.

The MAC addressing method has the following advantages:
• Simplifies implementation and ongoing support by eliminating the address 

administration issues inherent in network protocols. MAC addresses are 
predefined by Comtrol and there is no potential for an “address conflict” at 
setup. 

• It is isolated from foreign LAN segments minimizing potential security issues.

Using the Port 
Sharing Feature

The Comtrol device can be shared with multiple systems on a network. To do so, 
follow the Installing NS-Link discussion for each system that you want to permit 
access to the serial ports.
You can implement the port sharing feature in several ways. You can share the 
same port with multiple systems or you can set up multiple systems to share 
specific ports on the Comtrol device.

Note: Most applications do not release ports, so you may not be able to use port 
sharing across multiple systems with the same port. Also, if using port 
sharing, make sure that two computers do not try to access the same port at 
the same time. Only one computer can control a given port at a given time.

RocketPort Serial Hub 
ia

NIC Crossover
Network

Ethernet hub Standard

RocketPort Serial Hub 
Si (2-Port)

NIC Crossover
10/100BASE-T

Ethernet hub Standard

Product Type Connected to Ethernet 
Cable Connector 

Comtrol Device
Port 1 

System A System B

Port 2

COM 5 COM 6

Port 3 Port 4

COM 5 COM 6

Ethernet Hub

Configured for System A Configured for System B 

Example:
To configure two ports for System A and two ports for System B, 

1. When installing NS-Link on System A, select “Not Configured” for the 

2. When installing NS-Link on System B, select “Not Configured” for the 

COM port names must be unique to each system.
Multiple systems can use the same COM port names.

:

you could configure the drivers like this:

    COM port names for Ports 3 and 4.

    COM port names for Ports 1 and 2.



NS-Link Installation and Configuration

This subsection discusses the following installation and configuration issues:
• Removing an existing driver
• Installing the software
• Verifying the installation
• Programming the IP addresses
• Changing configuration parameters
• Adding additional Comtrol devices to an existing configuration
• Replacing devices

Removing an Existing Driver 

Use the following procedure to remove the existing driver. If updating (not 
reconfiguring) NS-Link for Windows NT, make sure that you remove the existing 
version before installing an updated driver. 
Note: Using the Remove button on the Comtrol Main Setup sheet only discards the 

software configuration, it does not remove the software.
1. Right-click on the Network Neighborhood, and select Properties.

2. Select the Adapters tab. 
3. Highlight Comtrol NS-Link and 

select the Remove button.
4. Select Yes to the warning that 

notifies you that this will 
permanently remove the driver.

5. Select the Close button. Several 
messages display as the system 
updates.

6. Select the Yes option to shut down 
and restart the system, so that 
your changes take effect.

After removing the existing driver, 
use the following subsection to install 
a new version.
Configuring NS-Link for Windows NT 8 



Installing the NS-Link Device Driver
Installing the NS-Link Device Driver

Use the following procedures to install NS-Link for Windows NT 4.0 operating 
systems.
Note: If updating NS-Link, first remove the existing version of NS-Link. Do not 

use the Update option.
The following procedures assume that you have already:
1. Installed the hardware.
2. Determined that the hardware is working properly.

Model How to tell if the hardware is working properly:

DeviceMaster 
RTS 1-Port

• The Status LED on the front of the unit is lit, which indicates 
that it has power and has completed the boot cycle.
Note: The Status LED flashes while booting and it takes 

approximately 15 seconds for the bootloader to 
complete the cycle.

• The red Link Act LED is lit, which indicates a working 
Ethernet connection.

• If the red Duplex LED is lit, it indicates full-duplex activity.
• If the red 100 LED is lit, it indicates a working 100 MB 

Ethernet connection (100 MB network, only).

DeviceMaster 
RTS 1-Port 
Embedded

The LEDs are located between the RJ45 connector and the power 
terminal block.
• The amber Status LED (D1) on the adapter is lit, which 

indicates that it has power and has completed the boot cycle.
Note: The Status LED flashes while booting and it takes 

approximately 15 seconds for the bootloader to 
complete the cycle.

• The red Link Act LED (D2) is lit, which indicates a working 
Ethernet connection.

• If the red Duplex LED is lit, it indicates full-duplex activity.
• If the red 100 LED is lit, it indicates a working 100 MB 

Ethernet connection (100 MB network, only).

DeviceMaster 
RTS 4/8/16 

With External 
Power Supply

• The PWR LED on the front of the unit is lit, which indicates  
it has power and has completed the boot cycle. 
Note: The PWR LED flashes while booting and it takes 

approximately 15 seconds for the bootloader to 
complete the cycle.

• The red LNK/ACT LED is lit, which indicates a working 
Ethernet connection.

• If the red 100 LED is lit, it indicates a working 100 MB 
Ethernet connection (100 MB network, only).
Configuring NS-Link for Windows NT 9 



Installing the NS-Link Device Driver
3. If necessary, unzip the self-extracting files from the Comtrol media or ftp/web 
site (Locating NS-Link Software and Installation Documentation on Page 5).
Note: The self-extracting zip file name has this format: 1800031#.exe, where # 

represents an alphabetic version such as E or F.

Double-click on the file name and follow the Winzip wizard, which 
creates a subdirectory on your hard drive and extracts the files.

4. Right-click on the Network Neighborhood, and select Properties.

DeviceMaster 
RTS 16/32RM 
With Internal 
Power Supply 

• The Status LED on the front of the unit is lit, which indicates  
it has power and has completed the boot cycle. 
Note: The Status LED flashes while booting and it takes 

approximately 15 seconds for the bootloader to 
complete the cycle.

• The red LNK/ACT LED is lit, which indicates a working 
Ethernet connection.

• If the red Duplex LED is lit, it indicates full-duplex activity.
• If the red 100 LED is lit, it indicates a working 100 MB 

Ethernet connection (100 MB network, only).

RocketPort 
Serial Hub ia

• The yellow PWR LED is flashing, which means that the 
device is waiting for the driver installation.
Note: If the PWR LED is lit, it means that the device driver 

has loaded.
• The green LNK LED is lit, which indicates a working 

Ethernet connection.
• The yellow ACT LED flashes, which indicates Ethernet 

activity on the network.

RocketPort 
Serial Hub Si 

2-port

• The Power LED in the front of the unit is flashing, which 
indicates that the device is waiting for the driver 
installation.
Note: If the Power LED is lit, it means that the device driver 

has loaded.
• Both 10/100BASE-T LEDs are lit, which indicates a working 

Ethernet connection.

Model How to tell if the hardware is working properly:
Configuring NS-Link for Windows NT 10 



Installing the NS-Link Device Driver
5. Select the Adapters tab and then the Add button.

6. Select the Have Disk button.

7. Enter the drive and directory path to the installation files and select the Ok 
button. For example, if you extracted NS-Link to a subdirectory named 
comtrol, enter: c:\comtrol

Note: This screen shot illustrates installing NS-Link from the default 
installation directory.

8. Select the Ok button when the selection box appears with Comtrol NS-Link 
highlighted.   
Configuring NS-Link for Windows NT 11 



Installing the NS-Link Device Driver
9. Select the Next button when the Add Device Wizard appears:

Note: The Add Device Wizard also contains help for each window.
10. Select the Comtrol device you are installing.

11. If queried, select the number of ports on this Comtrol device.
Configuring NS-Link for Windows NT 12 



Installing the NS-Link Device Driver
12. Select the starting COM 
port number for each port 
you plan to use on this 
system, if you do not want 
to allow access to a 
specific port for this 
system, scroll up to Not 
configured. When 
configuring ports among 
several systems, they can 
share the same COM port 
name or be assigned a 
unique COM port name 
on each system.
Note: This window is 

dependent on the 
number of ports on 
the device.

13. If this is the initial NS-Link installation and you have not programmed an IP 
address into the device, select MAC. If the device has been previously 
programmed with an IP address, you can select IP.
Note: If you want to use 

the device in an IP 
networking 
environment, you 
must first install 
NS-Link with a 
MAC address and 
then configure the 
IP address using 
the IP 
Programming tab 
(Page 21) in the 
NS-Link Device 
Properties 
window.

a. If you selected MAC, 
enter the MAC 
Address of the device that you are installing and select the Next button.

Note: The MAC address 
label is on the 
device and the 
format is: 00 C0 4E 
xx xx xx. A space 
must separate each 
two digits, as 
illustrated in the 
following screen 
shot.

If your site has 
other Comtrol 
network devices on 
the network, their 
MAC addresses 
will display in the 
drop list after initial installation.
Configuring NS-Link for Windows NT 13 



Installing the NS-Link Device Driver
b. If you selected IP, 
enter a unique 
reserved IP address 
or a qualified domain 
name (DNS) and 
select the Next 
button.

Note: If using DHCP or 
ARP, the 
administrator 
must reserve the 
MAC address of 
the Comtrol device 
to the IP address 
assigned to the 
device. If 
necessary, see your 
system administrator for a unique reserved IP address or qualified 
domain name.

14. Select the Finish button when the following window appears:

The Device Properties window appears after selecting the Finish button.

Note: If you select IP address in the previous window, the window is similar to 
the MAC version displayed.
Configuring NS-Link for Windows NT 14 



Installing the NS-Link Device Driver
15. Optionally, rename the NS-Link default name. 
16. Verify the Number of Ports on the device.
17. Optionally, set a different KeepAlive Timeout Period.

You can set the amount of time in seconds that this device waits until it closes 
this connection and frees all the ports associated with it. The KeepAlive 
feature works in the following ways:
• During normal operation the driver periodically sends a connection check 

to the NS-Link device, and the device then returns a response. There are 
two timers, one in the driver, and one in the device. These timers are reset 
when a connection check signal is received and goes to the next signal. If a 
connection is broken, the data is stored in the computer and the device. 
Depending on the amount of time that has expired since the connection was 
lost, the following happens:
- When the computer loses its connection to the device but re-establishes 

it before the timeout period expires, any data transmitted during this 
period is queued and sent when the connection resumes. 

- When the computer loses its connection to the NS-Link device and does 
not re-establish it before the timeout period expires; the driver then 
purges any pending I/O data for ports on that connection and returns 
all pending, and future I/O commands, with the exception of the Close 
command, to the application with an error indicating the disconnected 
status. 

This is similar to the processing which occurs when the computer 
receives a notification from the device that a port release request, from 
FreePort, was processed on a port it owns with the exception that a 
different status is returned. When the connection is re-established, the 
computer will attempt to re-acquire the ports that were open when the 
connection was lost. If the attempt is successful, normal operations 
resume for the port. If any port has been acquired, then the computer 
will continue to fail all further I/O operations, with the exception of a 
Close request. When the Close request is received, the port can then be 
re-opened.

- When the computer loses its connection to the NS-Link device, and the 
time period expires, the device places the port into a state from which 
another computer can establish a connection, locking out the original 
driver when the connection is made. The driver will respond to all I/O 
commands, with the exception of the Close command, with an error 
indicating the disconnect status.

If you need the ability to reconnect with a port that another system is 
currently using, Comtrol includes an utility called FreePort () and its source 
code which makes the API calls that would force a port closure. The included 
source code for FreePort demonstrates the calls an application would make to 
perform the same operation.

18. Optionally, set the TCP Timeout Multiplier value.
Use the TCP Multiplier to modify two timers used in TCP/IP socket 
communications. The first identifies how long the TCP protocol should wait 
before timing out an attempt to open a TCP channel. This timer defaults to 
500 ms when the TCP/IP address method is being used to communicate with a 
device. If the TCP Multiplier is changed to 2, the timer would now be 1000 ms, 
or 1 sec. If the multiplier is 4, the new timeout period would be 2000 ms, or 2 
sec.
The second timer defines how long the driver will wait for a response from the 
device when a forced release of a port is requested (i.e. as when the Freeport 
utility is being used). This timer defaults to 8 seconds. If the TCP Multiplier is 
changed to 2, the timer would now be 16 seconds. If the multiplier is 4, the 
new timeout period would be 32 seconds.

19. Verify the Network Address.
Configuring NS-Link for Windows NT 15 



Installing the NS-Link Device Driver
20. Select the Ok button. The NS-Link Setup window appears.

21. If you want to enable Verbose mode for Windows NT error messages or select a 
scan rate, select the Options tab. The Device Options window appears.

a. Select the options you want to implement.
Note: Typically, you should leave the scan rate set to the default value (10 ms) 

for most applications. 

To adjust latency for time-critical applications, select a longer or shorter 
interval from the droplist, or type in the rate (1 to 50). If a value larger 
than 50 is entered, the maximum of 50 is implemented.

Changes to Scan Rate do not take effect until you restart the system.
b. Select the Main Setup tab. 
Configuring NS-Link for Windows NT 16 



Installing the NS-Link Device Driver
22. Highlight the COM port that you want to configure and select the Properties 
button.

23. Select the appropriate RS 
mode to match the 
communications mode of the 
peripheral that you are 
connecting to that particular 
COM port.

24. Optionally, make any 
necessary changes to fit your 
environment:
a. Lock the baud rate to 

access higher or lower 
rates than are normally 
permitted by your 
Windows NT applications.

b. Set a time delay on the 
transmit data before a 
port closes.
Note: You can select the 

length of time to 
wait for data to 
clear the transmit buffer, before a close request from a host 
application is completed. If data is still in the transmit buffer, you 
can set a delay time to allow the buffer to empty. This is typically 
used with slower peripheral devices such as printers, to give the 
data sufficient time to flush through the system.

c. Map 2 stop bits to 1.
Note: You can use this option to map 2 stop bits to 1 bit. If the application 

you are using is hard coded to use two stop bits and you are 
receiving framing errors, you can implement this option. Leave this 
box unchecked to enable stop bits to pass through unchanged. 

d. Wait for physical transmission before completing write.
Note: Use this option to force all write packets to wait until the transmit 

data has physically completed the transmission before returning 
completion to the host application. The default mode (box not 
checked) is to buffer the data in the transmit hardware buffer and 
return completion as soon as the packet is in the buffer.
Configuring NS-Link for Windows NT 17 



Installing the NS-Link Device Driver
e. Emulate modem hardware ring signal.
Note: This emulates a hardware RI (ring indicator) signal.

f. Clone port settings.
Note: If this box is checked, the changes you make in the general COM 

Properties window are applied to all NS-Link ports in the 
system. 

The check mark is not permanent. It is only visible until the COM 
Properties window is closed. Upon re-opening the COM Properties 
window, the check mark is not visible.

If this box is not checked, the changes you make to the Port Setup 
options apply to the selected port only. 

g. If you need to configure 
RTS options, select the 
RTS Toggle tab.

h. Configure the port and 
select Ok after making the 
appropriate selections.
The Override and lock to 
RTS (Ready to Send) toggle 
mode option allows you to 
lock the port in RTS toggle 
mode, then set the mode 
(low or high) as desired. 
The RTS Toggle RTS Low 
option allows you to toggle 
the RTS output signal low 
during data transmission. 
If the option box is not 
checked, RTS is toggled 
high (asserted) during 
data transmission.

25. After configuring your port 
(COM) properties, select the Ok 
button. The Main Setup 
window returns.

26. If you did not clone all the 
COM ports, repeat Steps 22 
through 25 until all of the COM 
ports that you want to use are 
configured.

27. Select the Ok button after you 
have configured each port. 

28. To add another NS-Link device, 
highlight the first device and 
select the Add button. Follow 
Steps 9 through 29 to complete 
installation.

29. Select Yes to save the 
configuration and exit.

30. Select the Ok button to restart Windows.
Configuring NS-Link for Windows NT 18 



Disabling DHCP Requests (MAC Mode)
31. Select the Add button if you want to 
add a device (from another 
manufacturer) at this time or the 
Close button in the Network 
window. See Adding Devices After 
the Initial Installation on Page 29 
to install multiple Comtrol devices.
Note: You must configure at least 

one valid NS-Link Device.
32. Select Yes to shut down and restart 

the system.
Note: Initial installation is not 

complete until you have rebooted the system.
33. After rebooting, verify that you have a working installation. 

To verify your installation, test a port using Test Terminal (Page 31) or check 
the Device Advisor tab to see if the device is functioning properly (Page 39).

34. Go to the appropriate subsection to configure NS-Link for your installation.
• To configure an IP address in the device, go to Programming the IP Address 

on Page 21.
• To configure NS-Link in MAC mode to run efficiently, go to Disabling 

DHCP Requests (MAC Mode) on Page 19.

Disabling DHCP Requests (MAC Mode)

After installing NS-Link and restarting the system, you may want to disable the 
DHCP requests that are periodically sent from the device. Use the following 
procedure to disable DHCP requests sent from the Comtrol device.
1. Go to the Start button and 

select Programs/Comtrol NS-
Link/Comtrol Hardware Setup.

2. Highlight the device name of 
the unit you want to program 
and select Properties. 
Configuring NS-Link for Windows NT 19 



Disabling DHCP Requests (MAC Mode)
3. Select the IP 
Programming tab.

4. Select the Disable 
button.
Note: Not available 

on all NS-
Link devices. 
If the button 
is greyed out, 
then this 
feature is not 
available.

5. Select the Reset 
button and wait until 
the device reloads.
Note: The Comtrol 

device cycles 
its LEDs.

6. Select Ok to close 
the Device window.

7. Select Ok to close 
the Properties window.

8. Set up modems or printers using Windows NT Configuration Overview on 
Page 45, if necessary.
Configuring NS-Link for Windows NT 20 



Programming the IP Address
Programming the IP Address

After installing NS-Link and restarting the system, use the following procedure to 
program the IP address in the Comtrol device.
Note: To perform the following procedure, you must have previously entered the 

MAC address in the Device Setup tab and rebooted your system to access the 
device using the MAC address.

Programming the IP address can only done in a system that is operational in MAC 
mode. Verify that your ports are functional before proceeding using Test Terminal 
(see Using Test Terminal on Page 31).
See your System Administrator to acquire a unique reserved IP address if you are 
using DHCP. They will need the MAC address of the unit to provide you with an 
IP address.
1. Go to the Start button and 

select Programs/Comtrol NS-
Link/Comtrol Hardware Setup.

2. Highlight the device name of 
the unit you want to program 
and select Properties. 

3. Select the IP 
Programming tab.

4. Select the Retrieve 
button to check to 
see if the Comtrol 
device has been 
programmed with 
an IP address, 
gateway, and subnet 
mask.

5. Select the Ok button 
to retrieve the 
values.
Configuring NS-Link for Windows NT 21 



Programming the IP Address
6. If NS-Link retrieves the values assigned by the System Administrator, this 
means that the hardware has been previously configured and go to Step 21.

Note: The default address for the DeviceMaster RTS is 192.168.250.250.
If NS-Link returns all zeros, go directly to Step 7.
If NS-Link did not retrieve the correct values (not zeros):
a. Select the Clear button.
b. Select the Ok button to clear the IP programming in the device.
c. Select the Ok button to the IP programming not complete until the device 

is reset popup.
d. Select the Reset button and wait until the device reloads.
e. Repeat Steps 4 through 6

Note: The Comtrol device cycles its LEDs.
7. Enter the IP address, 

subnet mask, and 
gateway values in 
the IP Settings area. 
In the event that 
this unit is to be 
used on the same 
Ethernet segment as 
the PC that has NS-
Link installed, the 
following options 
may be valid.
If you do not have an 
assigned gateway 
address to use, you 
may use as the 
gateway address the 
IP address of the PC 
that has the NS-
Link driver 
installed. If 
necessary, execute 
IPCONFIG from a 
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command prompt to determine your IP address. Use the address of the default 
gateway if shown. 
If a default gateway is not shown, use the IP address displayed. The subnet 
mask value used in the Comtrol device should be the same as shown for the 
PC in this instance.
In the event that this will be used on another Ethernet segment, the IP 
address, subnet mask and gateway must be configured appropriately for that 
Ethernet segment. If you are unsure of these values, contact your system 
network administrator.
If you program the Comtrol device for a different Ethernet segment, after you 
put the IP address into NS-Link, you will be unable to use the device until it is 
physically connected to that network due to not having appropriate routing.

8. Select the Program button.
9. Select the Ok button to begin programming the device.
10. Select the Ok button to the IP programming not complete until the device is 

reset popup.
11. Delete the contents of the IP Address, Gateway, and Subnet Mask fields.

12. Select the Reset button.
13. Select the Retrieve button.
14. Select the Ok button to retrieve IP programming from the device.
15. Verify that the information that loads into the IP Address, Gateway, and 

Subnet Mask fields matches the information that you previously entered.
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If not, re-enter the 
IP Address, 
Gateway, and 
Subnet mask 
information and 
repeat Steps 8 
through 13.

16. If you are not using 
DHCP or ARP, then 
select the Disable 
button.
Note: Not available 

on all NS-
Link devices. 
If the button 
is greyed out, 
then this 
feature is not 
available.

17. Select the Reset 
button to soft boot 
the device.
Note: The Comtrol device cycles its LEDs.

18. Select the Ok button to reset the entire device. 
19. Select the Device tab.
20. Uncheck the MAC box and then check the IP checkbox.
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21. Select the Ok button to close the Device window.

22. Select the Ok button to close 
the Setup window:

23. Save the configuration 
changes and exit.

24. Reboot the system and verify 
that the device is running 
properly using Step 33 on 
Page 19.

25. Connect your serial devices to 
the Comtrol device. If you 
need information about 
connecting your serial 
devices, see Locating 
Hardware Installation 
Documentation on Page 5 for 
your product.

26. Set up modems or printers 
using Windows NT 
Configuration Overview on 
Page 45, if necessary.

27. DeviceMaster RTS: If you want to configure any of the ports as sockets:
a. Enter the IP address of the device in your web browser URL field.
b. Select the port number that you want to configure as a socket.
Note: See the DeviceMaster RTS Installation and Configuration Guide, if you 

need help configuring sockets. You can download the latest version at: 
ftp://ftp.comtrol.com/Dev_Mstr/RTS/RTS_Library.pdf.
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Changing Configuration Parameters

Use the following procedure to change the:
• NS-Link properties, such as:

- Name of the Comtrol device
- Keepalive timeout period
- Number of ports being used by this host system
- TCP Multiplier value
- Network address
Note: You can change the network address type by clicking on the current 

checkbox type, followed by placing a check in the other network type and 
entering the appropriate address. If replacing hardware, you have to 
change the MAC address. If necessary, see Programming the IP Address 
on Page 21.

- Device options, for example, Verbose mode or using a scan rate.
• COM port properties, such as the port mode (RS-232, RS-422, or RS-485) and 

application-related options discussed in Step 23 of the installation process.

Before changing the communications mode in NS-Link for an 
existing port, make sure that you disconnect the peripheral 
device from the port.

Use the following procedure to change configuration parameters.
1. Select the Programs/Comtrol NS-Link/Comtrol Hardware Setup option from the 

Start button.
2. To change the NS-Link properties for the device (name, number of ports, or 

network address) highlight the device name and select the Properties button.

Caution
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3. Make the desired changes and select the Ok button.

4. To change device options (Verbose mode or scan rate), select the Options tab, 
make the changes, and toggle back to the Main Setup tab.
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5. To change port configuration, highlight the COM port that you want to change 
and select Properties.

6. Make the port configuration 
changes and select the Ok 
button.
a. Before changing the 

communications mode in 
NS-Link for an existing 
port, make sure that you 
disconnect the peripheral 
device from the port.

b. If you change the mode of 
the port, select Ok to the 
popup regarding changing 
the mode of connected 
devices:

7. Select Ok to save your 
configuration changes. 

Note: Depending upon the type 
of configuration changes 
you made, you may or may 
not need to reboot your 
system. The driver will 
prompt you to save the 
changes, if necessary.

8. Select Yes to save the 
configuration and exit.

9. Select the Ok button to 
restart windows.
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Adding Devices After the Initial Installation

Use the following procedure to add more NS-Link Comtrol devices to an existing 
installation.
1. Connect the new device to the network and power it up.
2. Make sure that the device passes the power-on LED diagnostics.
3. Select the Programs/Comtrol NS-Link/Comtrol Hardware Setup option from the 

Start button.
4. Select the Add button. 

5. For help with the 
remainder of the setup, 
use Installing the NS-
Link Device Driver and 
start with Step 9 (Page 
12).

6. Reboot the system so 
that the new device 
initializes.
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Replacing NS-Link Devices

On occasion, it may be necessary to replace an existing and configured Comtrol 
device with an identical device, without downing the system or reconfiguring 
ports. To do so, follow these steps:
1. Shut off the old device, connect all cables to the corresponding ports on the 

spare device, and power up the new device.
Make sure that you re-cable the spare exactly like the original. A 
remote chance exists that you could damage a peripheral if it is 
incorrectly connected to a port configured for the wrong 
communications mode.

2. Write down the Network (MAC) Address of the spare device on the customer 
service label provided.

3. Select the Programs/Comtrol NS-Link/Comtrol Hardware Setup option from the 
Start button.

4. Highlight the name of the NS-Link device that you want to swap out and 
select the Properties button.

5. Enter the new 
network (MAC or IP) 
address of the new 
Comtrol device. 
Note: Leave all other 

properties the 
same. 

6. If necessary, program 
the IP address (Page 
21).

7. Select Ok to exit the 
Device window and Ok 
to exit NS-Link Setup 
window.

8. Select Ok to save the 
new configuration.

The new device 
immediately replaces the 
old one under the old 
device’s device name. 
Note: Restarting the system is not needed.

Caution
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This section discusses the following utilities that are installed with most Comtrol 
drivers for Microsoft operating systems:
• Test Terminal program (wcom32.exe), which can be used to troubleshoot 

communications on a port-by-port basis (Using Test Terminal on Page 31).
• Port Monitor program (portmon.exe), which checks for errors, modem control, 

and status signals (Using Port Monitor on Page 33). In addition, it provides 
you with raw byte input and output counts.

• Device Advisor, which helps identify problems is a tab in the Device window of 
the NS-Link driver (Using the Device Advisor on Page 39).

• Peer Tracer program (peer.exe), which traces driver events (Using Peer Tracer 
on Page 42).

Using Test Terminal

WCOM32 is a terminal program that enables you to open a port, send characters 
and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is 

running or any other application is using the port. If you are using RAS, 
you must stop the service before starting WCOM32 to test RAS COM ports. 
To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:
1. Start Test Terminal from the Comtrol program group for your product.

2. Select Ok if this screen appears:

3. Select Open Port from the Port menu. A list of possible COM port numbers 
displays.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT Comtrol RocketPort RocketModem

RocketModem and 
RocketPort

Windows 2000, 
Windows XP Comtrol Utilities

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link
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4. Select the COM port you want to test.

If the COM port does not exist or if it is currently being used by another 
program, a Create File Error message displays.
If the COM port is available, a terminal window pops up:   

Note: Notice the <loop> button in the terminal window. If this option is 
activated, it is green and uppercase ( ), the COM port internal 
loopback feature is activated, and the data is returned by the COM port 
hardware. If this option is deactivated, it is gray and lowercase ( ), 
the internal loopback is deactivated, and the data is sent out the COM 
port.

Testing a Comtrol 
Device

Use the following procedure to test the Comtrol device.
1. Place a loopback plug on the COM port you are testing. Make sure all 

connectors are seated firmly and that the loop button is off. 
Note: Test terminal works for RS-232 and RS-422 mode.
To build loopback plugs, see the hardware installation document for the 
Comtrol device.

2. From the Port menu, select Send Test Data. The program sends out a repeating 
data stream. 
Note: To stop the data stream, select Send Test Data again. 
• If the loopback plug is in place and the port is working correctly, the test 

data should be echoed back to the screen. 
• If the loopback plug is not in place or the port is not working correctly, no 

data or garbled data is echoed back to the screen. 
Note: If no characters appear, insure that the loopback plug is attached to the 

correct port. 
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3. If further testing is required, select Loopback Test from the Port menu. 

If the loopback plug is in place and the port is 
working correctly, the system should return 
the message Passed.
If the loopback plug is not in place or the port 
is not working correctly, the system will return 
the message Failed. 

Testing a Comtrol 
Device (RS-485)

Perform the following procedure to determine if a port or ports are functioning 
properly.
1. Connect a straight-through cable from Port 1 to Port 2. 

Note: See the hardware installation document for the Comtrol device if you 
need to build a cable.

If testing ports other than Ports 1 and 2, simply connect the cable 
between any two ports.

2. Open a session for each port.
3. Enter data into the Port 1 session, the data should appear in the Port 2 

window.
4. Enter data into the Port 2 session, the data should appear in the Port 1 

window.
Note: If the data appears as described in Steps 3 and 4, the hardware is 

functioning properly.

Test Terminal 
Modem Control 
Signals

The terminal window displays the modem control signals as gray 
or green lights at the top of the window. The first four are inputs: 
The lights are green if they are turned on, or gray if off. The text 
on the light also changes from uppercase (CTS), which is on, to lowercase (cts), 
which is off.
The next two lights are outputs:  
Note: If you have a loopback plug connected and you click on one of the outputs, 

the corresponding signal is sent to the input and the input lights should 
toggle accordingly.

The rightmost light is the loop indicator:  
If this is on, the COM port internal loopback feature is activated and any 
information or code entered in the terminal window loops back through the COM 
port circuitry. If this is off, the COM port internal loopback is deactivated, and any 
information or code entered in the terminal window is sent out of the port.

Using Port Monitor

The Port Monitor program (portmon.exe) offers a summary of all Comtrol device 
statistics in one spreadsheet view. It also enables you to verify operation of all 
Comtrol device ports from a single window. 
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Starting Port Monitor
The Port Monitor display follows the familiar spreadsheet model: each COM port 
is a horizontal row, and each vertical column displays a variable or value for the 
respective COM port. For definitions of the abbreviations used, see Port Monitor 
Variables on Page 37.
Port Monitor can also produce statistics and reports that can help you verify the 
operation of the COM ports and connected peripherals. Some immediate feedback 
includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from the device driver
• Port errors
The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can 
cover all ports collectively or a separate report for each port. You can also set how 
often the values are recalculated, fine-tuning thoroughness against system 
efficiency, and automatically run external batch files to perform additional 
processing and analysis.

Starting Port 
Monitor

To run Port Monitor, select Port Monitor from the appropriate Comtrol program 
group. 

The Port Monitor window displays:

Note: To change the appearance of the screen, see the following discussion.
Once the monitor window displays, Port Monitor is active and collecting data. If 
any cumulative data has been saved from previous sessions, it is automatically 
brought in and used.
Port Monitor continues to run and collect data until you terminate it, at which 
point all accumulated data is automatically saved for use in the next session.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT Comtrol RocketPort RocketModem

RocketModem and 
RocketPort

Windows 2000, 
Windows XP Comtrol Utilities

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link
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Changing Screen 
Appearance

While Port Monitor is running, there are a number of commands and controls that 
change the appearance of the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply 
resets the selected display fields to their null values. For more information 
regarding calcs.dat, see Page  36.

Column Setup When you select Add or Properties from the 
column pop-up menu, the Column Setup 
window displays: 
• Use the Input droplist to select the 

variable displayed in the column.
• Use the Type droplist to select the way in 

which the value displays: either as an 
integer, as an on/off state, as an integer 
with a kilo, mega, or giga suffix, or as an 
hh:mm:ss time stamp. This defaults to the 
appropriate type for the selected Input 
variable.

• Use the Name variable to change the 
column heading name.

• Use the Width variable to specify the column width in characters.
• Use Color0 to set the column character color when the value is zero.
• Use Color1 to set the column character color when the value is not zero.
• When done, click OK to save your changes and return to Port Monitor.

Desired Change Procedure

Change the monitor 
window font. Select Font from the Edit menu.

Change width of a 
single column.

Left-click on the column separator (vertical) line and 
drag it to the desired width.

Change column 
placement.

Left-click in the middle of the column you want to 
move and drag it to the desired location.

Remove a column. Right-click on the column you want to remove and 
select Remove from the pop-up menu.

Clear all fields and 
reset them to null 
values.

Right-click on the upper left cell in the table and select 
Reset from the pop-up menu.*

Clear any single field 
except the upper left 
cell.

Right-click on the field to be cleared and select Reset 
from the pop-up menu.*

Add a column.

Right-click on the column now occupying the desired 
location and select Add from the pop-up menu.
You are prompted to name the variable you want to 
display, as well as other information. (See Column 
Setup, below.) 
After you click OK, the column is inserted in the 
selected location and the existing column is moved to 
the right.

Change other properties 
of a column.

Right-click on the column and select Properties from 
the pop-up menu. (See Column Setup, below.)
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Report 
Configuration

To configure reports, select 
Config from the Edit menu. 
The Single report options cover 
all ports and are overwritten 
each time the reports are 
generated. The Multiple report 
options generate a separate 
report for each port, and each 
report file is appended each 
time the report is generated.
For Hour reports, use the Single 
and Multiple droplists to select 
whether you are generating 
single or multiple reports, or 
both. For each report type, 
select from the following types 
of data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name are included.
• All Data: all variables are included.
• View Data: only variables that appear on-screen are included.
The External Program field is used to enter a command line to run another 
program after the hourly reports have been generated. For example, you can use 
this to run a batch file that performs custom report processing. The Test button 
causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your 
choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the names are 

included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor window are 

included.
Likewise, the External Program field is used to enter a command line to be 
executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port information is 
obtained and the calculations performed. There is a trade-off between Port 
Monitor efficiency and response time. If you are using Port Monitor to view the 
port activity on the screen, you may want to set the update time to 1 or 2 seconds, 
so that the screen is updated frequently. If you are concerned about the monitor 
program using CPU resources, set this to a higher value, (6 to 20 seconds) in order 
to decrease the time required by the program to perform the calculations and 
update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the 
display area of the program will help reduce the CPU overhead of updating the 
screen.

Port Monitor Files Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting 
with the appearance of the monitor screen, you can use the File menu Save option 
to save your customized layout in another.vew file. You can retrieve this file later 
by using the File menu Open option, or you can use the Edit menu View Default 
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option to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a 
binary file named calcs.dat. This enables you to halt Port Monitor execution 
without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are 
saved in this directory, under the following names:
• hall.txt — hourly single report
• dall.txt — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the 

multiple report files grow in size. It is up to you to delete them 
periodically.

Some safeguards are built into the program to avoid filling up a hard disk drive 
due to growing report files. The monitoring program stops writing additional data 
to the multiple reports if they reach a size of 2 MB. Also, the program will not 
write out data files to the disk drive if the spare room on the drive is less than 2 
MB in size.
To view or edit an hourly or daily report, use the Edit Report option on the File 
menu, or use a system tool such as NOTEPAD.
For more information, see the Port Monitor Help file.

Port Monitor 
Variables

The following table lists Port Monitor variables. 

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per 
second.

RxCPSInst Instantaneous average of receive characters per 
second.

Errors Total hardware receive errors (parity, framing, and 
overruns.)

TxMinCPS Last minute average of transmit characters per 
second.

RxMinCPS Last minute average of receive characters per 
second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.
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TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from the 
device driver.

RxTotalRaw Total number of receive bytes raw data from the 
device driver.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the 
last hour.

CDDayRunTime Time in seconds carrier detect has been on in the 
last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

Variable Description
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Using the Device Advisor

You can use the Device Advisor to determine the following information:
• Summary of the device status
• The MAC address of the network interface card (NIC)
• The Adapter ID string
• The Comtrol device’s MAC address
• Detailed state of the Comtrol device
• Total number of successful load attempts
• Total number of devices on the network
• Transmit statistics, such as the number of:

- Frames out
- Packets to device
- Retransmitted frames

• Receive statistics, such as the number of:
- Frames accepted
- Frames passed on
- Packets from device
- Out of sequence frames

Note: For detailed information about the fields in the Device Advisor, use the on-
line help available in the application.

OverrunErrorsRaw Total count of receive overrun errors, from the 
device driver.

FramingErrorsRaw Total count of receive framing errors, from the 
device driver.

ParityErrorsRaw Total count of receive parity errors, from the device 
driver.

Variable Description
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Starting the Device 
Advisor

Use the following procedure to access the Device Advisor:
1. Start the NS-Link menus using the Start button.
2. Highlight the device that you want to review and select the Properties button.

3. Click on the Device Advisor tab. 

The Device Advisor screen appears providing you with information that you 
may find useful.
Note: For information about the fields in the Device Advisor, use the on-line 

help available in the application.

Device Advisor 
Driver Messages

The following tables provide information about device driver summary messages 
and reported state messages. 

Message Description

Unintialized Comtrol device has not been installed correctly.

Unable to contact the NS-
Link driver

The Comtrol device NS-Link is not installed or is 
not responding to Device Advisor requests.
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Unable to contact a Network 
Interface Controller (NIC)

The server NIC card may not be installed, may be 
malfunctioning, or may not be bound to the 
Comtrol device.

Cannot detect network
No inbound traffic of any sort Comtrol device may 
be inoperative or you may have a network cabling 
problem.

Cannot detect any NS-Link.
Network traffic is being received, but not from a 
Comtrol device. Check the network connections 
and verify that the Comtrol device is powered up.

Cannot detect NS-Link with 
specified MAC address.

Network traffic is being received from a Comtrol 
device, but not the one specified in Device Setup. 
Check the device to make sure that you are using 
the correct MAC address in Device Setup, and 
check the Main Setup window to verify that you 
are working with the correct device.

NS-Link device with specified 
MAC address was detected, 
but is not configured for this 
server.

Either the Comtrol device in question is not 
assigned to this server, or it is not assigned to any 
server, or it has been configured for this server but 
the configuration has not been saved. If the latter, 
return to the Setup window, save and exit, and 
restart the server

NS-Link device detected and 
configured for this server, but 
is not yet assigned to this 
server.

Either the Comtrol device is currently being 
controlled by another server or the device power 
has been cycled and the device is waiting for a 
server to acquire it.

NS-Link detected, 
initializing.

The server has acquired the Comtrol device and is 
downloading the control program. The device will 
be available shortly.

NS-Link responsive, but no 
data traffic exchange since 
last inquiry.

The Comtrol device appears to be installed 
correctly and active, but no data traffic has been 
sent or received since the last time you clicked the 
Refresh button. If there should have been traffic, 
check the Comtrol device port configuration and 
external cabling.

NS-Link responsive; data 
traffic received, but nothing 
sent since last inquiry.

Similar to above, except the Comtrol device has 
received data successfully.

NS-Link responsive; data 
traffic sent, but nothing 
received since last inquiry.

Similar to above, except the Comtrol device has 
sent data successfully.

NS-Link active. Normal state: the Comtrol device is installed 
correctly and active with data traffic.

Poor connection to NS-Link.

This message displays if retransmissions occur, 
frames arrive out of sequence, or more than 2% of 
the total packets arrive out of sequence. This 
generally indicates a cable, connector, or LAN 
termination problem.

Counts reset. This message displays immediately after you click 
the Reset button.

Message Description
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Using Peer Tracer

The Peer Tracer program (peer.exe) is specifically designed to view the internal 
operations of the device driver for the purpose of troubleshooting communications 
on Windows NT, Windows 2000, and Windows XP systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and 
receive text information to and from the device driver. To use Peer, you type in 
commands, and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the commands 
sent and the results received in a file named peer.log. Comtrol Technical Support 
may ask you to run Peer in order to help diagnose reported problems.

Starting Peer Peer Tracer does not appear in most Comtrol program groups and you may need to 
start the application from the Windows Explorer. Use the table below to determine 
whether you can start Peer from a program group or where to locate the 
executable. 

Message Description

Invalid An illegal Comtrol device state has been detected. Reset the 
Comtrol device.

Init This is the normal state for undetected and inactive Comtrol 
device.

InitOwn The server has acquired the Comtrol device but has not 
downloaded the control software.

SendCode The server has acquired the Comtrol device and is in the process of 
downloading the control software.

Connect The server has completed the download and is completing 
initialization.

Active The normal state for a Comtrol device that is attached to a server 
and is ready for data traffic.

Not found The specified MAC address is not configured on this server.

Undefined No Comtrol devices are configured on this server.

Product Operating 
System Starting Peer

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
RocketPort Serial Hub Si

Windows NT, 
Windows 2000, 
Windows XP

\WINNT\system32\rpshSi\peer.exe

RocketModem and 
RocketPort Windows NT \WINNT\system32\rocket\Peer.exe

RocketModem and 
RocketPort

Windows 2000, 
Windows XP Comtrol Utilities
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Log Functions
To start Peer, you may need to open 
the Windows Explorer, access a 
specific directory, and double-click 
on peer.exe or start peer using the 
Comtrol Utilities program group. 
The Peer Tracer window displays (at 
right). 

Log Functions All logging functions are found under the File menu. To start keeping a log, select 
Log to Disk from the File menu. The other options on this menu are View Disk Log, 
Clear Disk Log, Clear Screen, and Exit.

Using Peer To use peer, simply type in commands at the : prompt. (It may be necessary to 
press Enter to make the : prompt appear.) For example, to examine COM5, type: 
PORT COM5 <Enter>

To gather some information about the port, type: STAT <Enter>. This should 
return details about the port.
To turn on monitoring of any calls into driver (events), type: MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send 
“ATH0” to a modem—type: SEND ATH0 <Enter>. A return and linefeed are always 
appended to each string sent.

Other Peer 
Commands

Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in the device driver, and that Peer 
simply acts as a conduit for this information. 
For more information, see the Peer.hlp help file.

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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Using Freeport 

FreePort is an application utility that provides a simple mechanism to 
communicate to the NS-Link device driver that it should request the physical 
device to close the physical ports which are associated with the specified logical 
ports. 
See the Freeport.cpp file (bundled with the driver) for a simple example on how 
other applications could implement this capability themselves. The Freeport.cpp 
file can be found in the C:\WINNT\System32\RpshSi subdirectory after driver 
installation.



Windows NT Configuration Overview

Configuring Modems

After installing the hardware and driver for Windows NT, you can use this 
discussion to configure modem COM ports.
The Comtrol device can support any asynchronous serial modem for use by any 
application that uses TAPI. For information regarding port pinouts and signals, 
see Locating Hardware Installation Documentation on Page 5.

Working with NT 
RAS

Comtrol products are frequently used to provide Dial-Up Networking access with 
NT RAS (Remote Access Service). 
• If RAS is not installed, note that you must install at least one RAS-capable 

device (for example, modem) before installing and configuring RAS.
• If RAS is installed, note that the modem installation process automatically 

launches RAS Setup after modem installation is complete.

Installing Modems The following instructions were developed using Comtrol modem products. If you 
are using another brand of modem, note that some prompts and window 
descriptions may differ from those shown.
Follow these steps:
1. Connect the modem to the desired port. 
2. Power up the modem.
3. Open the Control Panel window.
4. Double-click the Modems icon.

If you have no other modems installed, skip to Step 5.
If you have already installed another modem, the Modems Properties window 
displays. Select the Add button.
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Installing Modems
5. Check the “Don’t detect my modem...” box and select Next.

Note: While Windows NT can automatically detect modems, we advise against 
using this option as auto-detect feature may cause some multiprocessor 
systems to lock up, and the modems may be installed in reverse order.

6. Select the appropriate manufacturer and model and select OK. If the correct 
manufacturer and model do not appear on the list, select Have Disk to install 
software from a manufacturer-supplied installation diskette.

7. Select the COM port number.
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Further Modem Configuration
8. Select Finish. The modem software is installed on the selected ports.

Depending on prior configuration, you may be asked to enter your country of 
use, area code, the number you dial to get an outside line, and whether you 
have tone or pulse dialing at this time.

9. If you need to configure modem 
properties (maximum baud rate, data 
bits, parity, and so on), select the 
Properties button, make the needed 
changes, then select OK to return to this 
window.
Note: For help configuring modem 

properties, see the Windows Help 
System.

10. If you need to configure dialing 
properties (country, area code, calling 
card number, and so on), select the 
Dialing Properties button, make the 
needed changes, then select OK to 
return to this window.

11. Select Close.

Further Modem 
Configuration

At this point:
• If you are not using RAS, you are now finished. Reboot the system so that your 

changes take effect and resume normal operations.
• If you plan to use RAS but do not have it installed yet, reboot your system, 

then go to Installing RAS Initially on Page 48.
• If you already have RAS installed and configured, this dialog box displays. 

If you do not want to configure this modem for use with RAS at this time, 
select No, then reboot and resume normal operations.
If you do want to configure this modem for use with RAS, do not reboot. 
Instead, select Yes, then go directly to Adding or Reconfiguring a RAS Device 
on Page 49
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Installing and Configuring RAS
Installing and Configuring RAS

After installing the hardware and driver, and installing and configuring at least 
one RAS device (for example, a modem), use this section to install and configure 
Remote Access Service (RAS).

Installing RAS 
Initially

If you have not previously installed RAS in your Windows NT system, log into the 
system with Administrative rights and follow these steps:
Note: This example shows how to install and configure RAS for use with modems, 

but you can use it as a guide to setting up other serial devices.
1. Open the Control Panel and start the 

Network applet, or right-click on the 
Network Neighborhood and select 
Properties.

2. Select the Services tab and select the 
Add button. 

3. Highlight Remote Access Service 
and select the OK button.
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Adding or Reconfiguring a RAS Device
4. Enter the location of the 
Windows NT files (for example, 
d:\i386) and press the Continue 
button. 
The appropriate files are copied 
onto your hard drive.
The RAS installation process 
automatically launches the Add 
RAS Device process. Go to 
Adding or Reconfiguring a RAS 
Device on Page 49, Step 5.

Note: If you install or reinstall RAS from your original Windows NT 4.0 
distribution media, you must install or reinstall the latest Windows NT 
Service Pack after installing/reinstalling RAS. This is necessary because 
most Service Packs include RAS-related files that are newer than the files on 
the NT distribution media.

Adding or 
Reconfiguring a 
RAS Device

There are several different ways to start this procedure:
• If you have previously installed RAS and configured at least one RAS device, 

and are now adding or reconfiguring RAS devices, begin with Step 1.
• If you have previously installed RAS and were in the process of installing a 

modem when this process started automatically, begin with Step 3.
• If you were in the process of installing RAS when this process started 

automatically, begin with Step 5.
Follow these steps:
1. Open the Control Panel and start the 

Network applet, or right-click on the 
Network Neighborhood and select 
Properties. The Network window 
displays.

2. Select the Services tab.
3. Highlight Remote Access Service and 

select the Properties button. 
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Adding or Reconfiguring a RAS Device
4. To reconfigure an existing RAS port, highlight the port/device and select the 
Configure button. Then go to Step 7.

5. To add a new RAS device—for 
example, if you are configuring a 
new modem—select the Add button. 
The Add RAS Device window 
displays:

6. Use the droplist to select the COM 
port (modem) that you want to 
configure and select the OK button.
Note: If no modems appear on this 

list, you need to install a 
modem, see Installing Modems on Page 45.

The Remote Access Setup 
window displays again.

7. Highlight the desired 
COM port (Modem) and select the 
Configure button. The Configure Port 
Usage window displays.

8. Select the appropriate radio button, 
based on the role the modem will 
perform, and select the OK button. 
Note: When configuring multiple 

simultaneous RAS dial-in 
ports, configure the ports to “Receive calls only” not “Dial out and 
Receive.” Configuring a port to dial-out requires a separate memory pool 
for each dial-out port, while all ports configured for receive-only share 
the same memory pool.

If you configure too many ports for dial-out unnecessarily, resources can 
become an issue. If you require dial-out on the RAS server, configure one 
port to “Dial out and Receive” and all the other ports to “Receive calls 
only.”
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Adding or Reconfiguring a RAS Device
The Remote Access Setup 
window displays again. 

9. Highlight the COM port 
(modem) again and select the Network 
button.

10. Select the appropriate dial out protocols, 
dial in protocols, logon security levels, 
enable multilink (if required) and select 
OK.
Note: Only previously configured protocols 

are selectable. If you want to set up a 
protocol that is grayed out, you must 
first add it using the Network 
Protocols tab.

If you selected “Receive calls only” on all 
ports while configuring the port usage, the 
“Dial out Protocols” area will be shaded.
If you want to use Multilink PPP 
(bonding), make sure that you select the 
Enable Multilink checkbox. 
For detailed information about the 
configuration windows, use the Help button or the Windows NT CD-ROM 
(Support/books/server.hlp file to locate information).

Note: The following steps are dependent upon the protocol selections made in this 
window.

11. If you select NetBEUI on the Network 
Configuration window, the following 
window displays. Make the appropriate 
selection for your environment and select 
OK. 
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Configuring Printers
12. If you select TCP/IP, the following window displays. Make the appropriate 
selections for your environment and press OK.

13. If you select IPX, the following window 
displays. Make the appropriate selection 
for your environment and press OK. 

14. Select OK to exit the Network 
Configuration window and return to the 
Remote Access Setup window.
Note: Choices made during network 

configuration will effect the entire 
system.

15. If you want to duplicate the configuration 
you just created on any other COM port 
(modem), highlight the COM port number 
and select Clone. Otherwise, repeat Steps 7 
through 14 for each COM port (modem) you want to set up.

16. After setting up all the COM ports, select the Continue button.
17. Select the Close button at the Network/Services tab to complete the RAS 

installation.
18. Select Yes when asked to reboot the computer. Windows NT RAS installation is 

complete.
19. If necessary, install the latest NT Service Pack or Packs from Microsoft.

Configuring Printers

Use this subsection to configure printers for the Comtrol device after installing the 
hardware and driver.
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Adding Serial Printers
Adding Serial 
Printers

Follow these steps to configure a serial printer in Windows NT:
1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable 

unless the printer maker specifies otherwise.
2. Open the Printers control panel and double-click on 

the Add Printer icon. 
3. Select the My Computer checkbox, then the Next 

button.

4. If the desired COM port is on 
this window, select it, select on 
the Next button, and skip to 
Step 6.

5. If the desired COM port is not 
on this list, select the Add Port 
button and follow these steps:
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Adding Serial Printers
a. A list of printer ports is displayed. 
Select Local Port.

b. Select New Port.
c. Type in the name of the port.

Note: Port names above COM9 require 
the \\.\ prefix. For example, to reference COM12, enter \\.\COM12: 
(make sure that you add the colon)

d. Select the OK button. 
e. Select the Close button to return to the Add Printer Wizard.
f. Select the Next button.

6. Select the printer make and 
model and select the Next 
button. 
If your printer is not on the 
make and model lists, but you 
have a manufacturer-supplied 
printer diskette, select the 
Have Disk button.
If you have already installed 
another printer using this 
driver, you are asked if you 
want to keep the existing 
driver.

7. To keep driver: check Keep 
existing driver, select Next, and 
go to Step 8.
If you choose Replace existing driver, or if you have not previously installed this 
driver, you are prompted to insert either the Windows NT CD-ROM or the 
manufacturer’s printer diskette. Do so and select Next.
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Changing Printer Port Configuration
8. Select whether you 
want this printer 
to be the Windows 
NT default printer, 
and select on the 
Next button.

9. Select whether or 
not you want to 
share this printer 
with other 
computers on the 
network. If you 
select Shared, you 
are asked to 
indicate the 
operating systems 
of all the 
computers that 
will be sharing this 
printer. (You may 
also be required to insert the operating system media so that Windows NT can 
extract the necessary driver files.)

10. Select whether to print a test page and select on the Finish button.
You are now ready to begin using the printer. No reboot is needed.

Changing Printer 
Port Configuration

If the printer does not successfully print the test page, it may be necessary to 
change the port baud rate, parity, and so on. If the Ports applet does not configure 
the port properly, you may have to use the mode command from a DOS prompt. 
Also, check the printer for DIP switches or other hardware configuration options.

Changing Printer 
Port Assignment

To change the port assigned to a printer, follow these steps:
1. Open the Printers control panel.
2. Right-click on the icon for the printer you want to change.
3. Select the Properties option from the menu. The Properties window is 

displayed. 
4. Select the Ports tab.

Note: The Properties window also gives you access to printer test and setup 
options that can be very helpful when debugging a serial printer 
installation.

5. Check the port you want to switch to. Remember to change your cabling 
accordingly.
Note: The Configure button on the Ports tab does not recognize Comtrol ports. 

This is a limitation of Windows NT. If you need to reconfigure the port, 
use the Ports option on the Control Panel.

6. Select on the OK button. Any changes you make take effect immediately. No 
reboot is needed.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your Comtrol device. You 
should review the following subsections before calling Technical Support because 
they will request that you perform many of the procedures or verifications before 
they will be able to help you diagnose a problem.
• Troubleshooting checklist
• General Troubleshooting on Page 58
• NS-Link Driver Troubleshooting on Page 59
• Daisy-Chaining DeviceMaster RTS 4/8/16 Units on Page 60
If you cannot diagnose the problem, you can contact Technical Support on Page 61. 

Troubleshooting Checklist 

The following checklist may help you diagnose your problem:
• Verify that you are using the correct types of cables on the correct connectors 

and that all cables are connected securely using the hardware documentation.
Note: Most customer problems reported to Comtrol Technical Support are 

eventually traced to cabling or network problems.
Isolate the unit from the network by connecting the device directly to a NIC in a 
host system. 

• Verify that the Ethernet hub and any other network devices between the 
system and the Comtrol device are powered up and operating.

Product Type Connected to Ethernet 
Cable Connector 

DeviceMaster RTS 1 Ethernet hub or NIC Standard 10/100 ETHERNET

DeviceMaster RTS 1 
Embedded Ethernet hub or NIC Standard RJ45 port

DeviceMaster RTS 4/8/
16 with external power 
supply

NIC Standard DOWN

Ethernet hub Standard UP

DeviceMaster 16/32RM 
with internal power 
supply

Ethernet hub or NIC Standard 10/100 NETWORK

RocketPort Serial Hub 
ia

NIC Crossover
Network

Ethernet hub Standard

RocketPort Serial Hub 
Si (2-Port)

NIC Crossover
10/100BASE-T

Ethernet hub Standard
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Troubleshooting Checklist
Reset the power on the Comtrol device and watch the PWR or Status light activity. 

• If the device has a power switch, turn the device’s power switch off and on, 
while watching the LED diagnostics. 
- If the unit does not have a power switch, disconnect and reconnect the 

power cord.
• Verify that the hardware MAC address in NS-Link matches the address on the 

Comtrol device.
• Verify that the network IP address is correct. If IP addressing is being used, 

the system should be able to ping the Comtrol device.
• Verify that the IP address programmed into the Comtrol device matches the 

unique reserved IP configured address assigned by the system administrator.
• If using a driver for Microsoft systems, verify that you are addressing the port 

correctly. In many applications, device names above COM9 require the prefix 
\\.\ in order to be recognized. For example, to reference COM20, use 
\\.\COM20 as the file or port name.

• If using NS-Link for a Microsoft system, you can use one of the tools bundled 
with the drivers:
- Test Terminal program (wcom32.exe), which can be used to troubleshoot 

communications on a port-by-port basis.
- Port Monitor program (portmon.exe), which checks for errors, modem 

control, and status signals. In addition, it provides you with raw byte 
input and output counts.

- Device Advisor, which helps identify problems is a tab in the Device 
window of the driver.

- If Windows NT, Peer Tracer program (peer.exe), which traces driver events.
• If using NS-Link for Windows NT hosts, enable the Verbose Event Log feature 

under the Setup Options tab and then reboot the system.
• Reboot the system and the Comtrol device.
• Remove and reinstall NS-Link.
• If you have a spare Comtrol device, try replacing the device. 

Product Type PWR or Status LED Description

DeviceMaster RTS
1
1 Embedded
4/8/16 (2 Ethernet ports)
16/32RM

5 sec off, 3 flashes, 5 
sec off, 3 flashes ... Redboot checksum failure.

5 sec off, 4 flashes, 5 
sec off, 4 flashes ... SREC load failure.

5 quick flashes The default application is 
starting up.

10 sec on, .1 sec off, 10 
sec on .1 sec off ...

The default application is 
running.

RocketPort Serial Hub ia
RocketPort Serial Hub 

Si (2-Port, only)

Flashing Bootloader is running.

On Firmware (rpshsi2p.bin) is 
running.
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General Troubleshooting
General Troubleshooting

This table illustrates some general troubleshooting tips.
Note: Make sure that you have reviewed the Troubleshooting Checklist on Page 56.

General Condition Explanation/Action

PWR or Status LED 
flashing

Indicates that boot program has not 
downloaded to the unit.
1. Make sure that you have downloaded the 

most current driver from http://
support.comtrol.com/download.asp. 

2. Install the driver and configure the device 
using the MAC address. Make sure that you 
reboot the system.
Note: If the PWR or Status LED is still 

flashing, contact Technical Support.
3. If you want to program an IP address into 

the Comtrol device, you can use the 
procedure outlined in NS-Link Driver 
Troubleshooting on Page 59.

4. Remove the NS-Link driver.

PWR or Status LED not 
lit

Indicates that power has not been applied or 
there is a hardware failure. Contact Technical 
Support.

Can ping the Comtrol 
device, but cannot open 
the ports from a remote 
location. 
(You must have 
previously programmed 
the IP address, subnet 
mask, and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to 
communicate with the Comtrol device. 
When using a “sniffer” to track NS-Link 
packets, filtering for Port 4606 will easily track 
the packet. The packet should also contain the 
MAC address of the device and the originating 
PC so that it can be determined if the packet is 
able to travel the full distance one way or not. 
If the 4606 packet is found on one side of a 
firewall or router, using sniffer, and not on the 
other side, then that port needs to be opened up 
to allow the 4606 to pass. 
This will most often be seen with firewalls, but 
is not uncommon in some routers.

Cannot ping the device 
through Ethernet hub

Isolate the unit from the network. Connect the 
device directly to the NIC in the host system 
(see Page 56).

Cannot ping or connect 
to the DeviceMaster 
RTS.

The default IP address is often not accessible 
due to the subnet masking from another 
network unless 192.168 is used in the network.
In most cases, it will be necessary to program in 
an address that conforms to your network. 
If you do not use the NS-Link driver to program 
the IP address, you only have 15 seconds to 
disable the bootloader with Redboot to get into 
the setup utility. 
See ftp://ftp.comtrol.com/Dev_Mstr/RTS/
RTS_Library.pdf for the Redboot method of 
programming an IP address.
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NS-Link Driver Troubleshooting
NS-Link Driver Troubleshooting

This table includes some tips related to NS-Link drivers.

NS-Link Condition Explanation/Action

Need to program IP 
address into the 
device.

Before programming an IP address it is critical that the 
unit be operational and passes the power on tests when 
configured for the MAC address. 
Note: If the unit is NOT operational, do NOT attempt to 

program or use an IP address with the unit.
This is a general procedure for drivers on Microsoft 
operating systems.
1. In the Comtrol Setup, highlight the Comtrol device.
2. Select Properties.
3. Select IP Programming.
4. Select Retrieve and confirm or modify addresses as 

necessary.
Note: Enter in all 3 categories. The unit must have 

Address, Mask and Gateway IP values entered.
5. Select Program.
6. Select Reset - power LED should begin blinking.
7. Select Device Setup.
8. Uncheck MAC.
9. Check IP and enter IP number that you configured 

earlier.
10. Select Ok (several times) and reboot the system.
IP addressing will now be in effect.

Cannot open port

1. Verify that MAC address in the NS-Link driver 
matches the address on the Comtrol device.

2. Verify that you are using the correct NS-Link driver. If 
necessary, remove and reinstall a new driver.

3. Isolate the unit from the network (see Page 56).
4. Check to see if another program or computer is active 

on this port.

The Comtrol device 
has a lower 
limitation of network 
bandwidth 
requirement of 64 
Kbps. 

At this speed the entire available bandwidth is required for 
the purpose of uploading the firmware from the driver to 
the Comtrol device. At lower speeds, timing issues will 
prevent the firmware from being successfully installed to 
the Comtrol device, thus preventing the device from 
normal operation.
When using the Comtrol device over a WAN link that is 
less than the recommended 64 Kbps, a timing modification 
may be made that will allow uploading of the firmware.
Load the driver locally to the device for the purpose of 
getting the firmware installed. The PC on the other side of 
the slow link can then “share” the port. The sharing may 
be exclusive as the firmware loader PC may not need to 
access the ports.
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Daisy-Chaining DeviceMaster RTS 4/8/16 Units
Daisy-Chaining DeviceMaster RTS 4/8/16 Units

The DeviceMaster RTS 4/8/16 models with external power supplies follow the 
IEEE specifications for standard Ethernet topologies. 
When using the UP and DOWN ports, the DeviceMaster RTS 4/8/16 is classified as 
a switch. When using the UP port only, it is a simple end node device.
The maximum number of DeviceMaster RTS 4/8/16 units, and the maximum 
distance between units is based on the Ethernet standards and will be determined 
by your own environment and the conformity of your network to these standards. 
Comtrol has tested with seven DeviceMaster RTS 4/8/16 units daisy-chained 
together using 10 foot CAT5 cables, but this is not the theoretical limit. You may 
experience a performance hit on the devices at the end of the chain, so it is 
recommended that you overload and test for performance in your environment. 
The OS and the application may also limit the total number of ports that may be 
installed.
Following are some quick guidelines and URLs of additional information. Please 
note that standards and URLs do change.
• Ethernet 10BASE-T Rules

- The maximum number of repeater hops is four.
- You can use Category 3 or 5 twisted-pair 10BASE-T cables. 
- The maximum length of each cable is 100m (328ft).

Note: Category 3 or 5 twisted pair cables look the same as telephone cables 
but they are not the same. The network will not work if telephone 
cables are used to connect the equipment.

• Fast Ethernet 100BASE-TX rules
- The maximum number of repeater hops is two (for a Class II hub). A Class 

II hub can be connected directly to one other Class II Fast Ethernet hub. A 
Class I hub cannot be connected directly to another Fast Ethernet hub.

- You must use Category 5 twisted-pair 100BASE-TX cables. 
- The maximum length of each twisted-pair cable is 100m (328ft). 
- The total length of twisted-pair cabling (across directly connected hubs) 

must not exceed 205m (672ft).
Note: Category 5 twisted pair cables look the same as telephone cables but 

they are not the same. The network will not work if telephone cables 
are used to connect the equipment.

• IEEE 802.3 specification: A network using repeaters between communicating 
stations (PCs) is subject to the "5-4-3" rule of repeater placement on the 
network:
- Five segments connected on the network.
- Four repeaters.
- Three segments of the 5 segments can have stations connected. The other 

two segments must be inter-repeater link segments with no stations 
connected. 
See http://www.optronics.gr/Tutorials/ethernet.htm for more specific 
information.
Additional information may be found at http://compnetworking.about.com/
cs/ethernet1/ or by searching the web.
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Technical Support
Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact 
Method

Corporate 
Headquarters Comtrol Europe

FAQ/Online http://support.comtrol.com/support.asp

Downloads http://support.comtrol.com/download.asp

Email  support@comtrol.com support@comtrol.co.uk

Web site  http://www.comtrol.com http://www.comtrol.co.uk

Fax (763) 494-4199 +44 (0) 1 869-323-211

Phone (763) 494-4100 +44 (0) 1 869-323-220
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